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Introduction 

Q increases the speed and accuracy with which market research surveys are analyzed.  

Learning more about Q and support 

The quickest way to find something out is to click on the Help menu and select 

Online Documentation Search.  This takes you to a web page where you can search 

through Q’s documentation. 

The easiest ways to learn how to use Q are to either read this book, or, to complete 

the online training (click on Help and Online Training).  Training is also available 

face-to-face and via web meetings for a fee. 

If you wish to understand what a particular option in Q does, either press the F1 

button on your keyboard, click on the Help button on a dialog box, or click on the 

Help menu and select the first option (the one with the   to the left of it; the first 

option will always be the help for whatever is on the screen).  Click on the Search tab 

in the help to search for specific terms. 

You can also get support by phoning Q (go to www.q-researchsoftware.com to find 

contact details for your region) or by sending an email (click on Help and Email 

Support…).  If your request is a standard problem, it will be quickly explained or you 

will be referred to appropriate documentation or training materials.  If your problem is 

new or unusual, a How To document will be prepared showing the steps required to 

complete the task. 

Obtaining Q 

The latest release of Q can be downloaded from: 

http://www.q-researchsoftware.com/us/download.aspx 

If you are using an old version of Windows, you may be asked to install additional 

.NET files; a link is available on the download page. 

License files 

A license file needs to be installed in order to use Q properly.  If the license file has 

not been installed, Q will operate with limited functionality. 

http://www.q-researchsoftware.com/
http://www.q-researchsoftware.com/us/download.aspx
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Q license files can be obtained by contacting sales@q-researchsoftware.com or by 

accessing your customer page.  Q license files have a file extension of .qlic (e.g., 

your company name license.qlic). 

Double click on the Q license file to install a license. 

Checking for new versions of Q 

The first time Q is opened each day, it automatically checks for new versions.  If your 

network/internet setup blocks this, you can manually check whether a new version of 

Q has been released by clicking on Check for New Version of Q in the Help menu.  

An internet browser window will open with the results of the check.  You will either be 

notified that you are already running the latest version of Q, or that there is a new 

version available.  If a new version is available, all the changes that have occurred 

since the last version will be listed and you will be given the option to download the 

new version; you should always download the new recent version. 

 

mailto:sales@q-researchsoftware.com
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Getting started 

Start Q by double-clicking on either the   icon on your desktop or the one located 

in Windows’ Start menu. 

Starting a project 

Q uses two different files: a data file, which contains the data from a market research 

study, and a Q Project File which stores all of your work in Q (e.g., tables you have 

created). 

Q reads data from SPSS data files (file extension of .sav or .sps), CSV files (.csv) 

and triple-s files (.sss and .asc or .csv). 

To start a project, select Import New Data File (New Project)… from the File menu 

and select a data file you wish to analyze in Q.  You may be asked Would you like Q 

to tidy up SPSS variable labels?  If you select Yes, which is usually appropriate, Q 

will strip out any repetitive text that appears in labels within a multiple response 

question (e.g., if the labels were Satisfaction: Citibank and Satisfaction: Bank of America, 

Q will replace these with Citibank and Bank of America).  Q will then ask Would you 

like Q to automatically group like variables to create multiple response 

questions?  It is generally a good idea to select Yes.  More detail about setting up 

projects is contained in Data manipulation and preparation, page 43, and the Q 

Reference Manual. 

SPSS data files contain both the raw data (i.e., all the numbers) 

and the meaning of the data.  For example, an SPSS data file may contain a variable 

with a Name of Gender, a Variable Label  explaining how to interpret the variable 

(e.g., What is your gender?) and Value Labels, showing that a value of 1 indicates that 

a respondent is Male and a value of 2 indicates that they are Female, and a series of 

1s and 2s representing the answers of individual respondents. 

Often multiple response questions are not appropriately set up in data files.  For 

example, a question such as Which of the following brands of soft drink did you drink in 

the past week?  Coke, Pepsi, Fanta, Diet Coke, V may be stored in SPSS as five different 

variables (one for each brand). Q will recognize that they are all from the same 

question if the SPSS data file indicates that they are in the same Multiple Response 

Set.  This can be done quickly and easily in Q (see Sharing and updating projects, 

page 52 and following).  If the SPSS file has been set up appropriately then Q will 

automatically recognize the multiple response questions. 

SPSS data files 
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CSV data files are text files which use a comma to separate 

different variables.  Most programs used for the collection and storage of market 

research data can export data as CSV files.  To convert an Excel spreadsheet into a 

CSV file you select Save as… from the File menu and select the Save as type as 

CSV (Comma delimited) (.csv). 

Although Q can use CSV files, it is almost always preferable to use SPSS data files as 

CSV files contain no information to assist in interpreting the data (e.g., CSV files do 

not contain Variable Labels, Value Labels and Multiple Response Sets). 

Saving and opening projects 

Projects are saved using either Save Project or Save Project As… in the File menu.  

Once you have saved a project, re-open it by selecting Open Existing Project… from 

the File menu.  That is, while a project is started by importing a data file, once the 

project has been started you do not need to import the data again.  Q will 

automatically read the data file associated with your project. 

The rest of this guide explains how you can use Q to analyze data.  All of your work is 

saved as a Q Project File, which has a file extension of .Q.  Q makes no modifications 

to the underlying data itself – this makes it easy to update reports with new data (see 

Updating tables with new or revised data, page 52). 

The Tables, Variables and Questions, Data and Notes tabs 

When you start Q, you are in the Tables tab; this is where most data analysis is 

performed.  Change tab by clicking on the tabs at the bottom left of the screen          

( ).  The Variables and Questions tab is used to 

reorganize the data (e.g., grouping together variables, creating complicated filters, 

recoding).  The Variables and Questions tab is discussed in more detail on page 46 

and following.  The Data tab shows the raw data; it is discussed in more detail on 

page 43.  Notes can be written in the Notes tab. 

Multiple data files 

You can analyze multiple data files at the same time.  Additional data files are added 

by selecting File  Add Data File to Project….  Plots can be created using data from 

different data files provided that both files contain a Date question with identical 

Name for the variable and Question.  The relationships between data files can be set 

using File  Edit Data File Relationships…. 

 

CSV data files 
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Creating tables 

Tables are created by selecting questions in the blue and brown drop-downs on the 

Tables tab – see Figure 1. 

 

Figure 1.  Blue and brown drop-downs 

There are three ways that you can select questions using the drop-downs: 

 Click on the  on the right of the drop-downs and select the question. 

 Click in the drop-down and select the question by using your mouse or the 

cursor keys on your keyboard and press the Enter key on your keyboard. 

 Click in the drop-down, type a word or phrase and select from the questions 

containing the typed word or phrase.  For example, Figure 2 shows three 

questions all containing age. 

 

Figure 2.  Quicksearch example 

Figure 3 shows an example of a table produced by Q (in some other programs this is 

called a Frequency Table).  There are a couple of key things to note about this table: 

 Using an expert system, Q has automatically deduced that the appropriate way 

of looking at the data is to use percentages. 

 Rather than show a Total, Q shows a NET.  It adds up to 99%, rather than 

100%, because only 99% of the sample answered this question.   

 



  CREATING TABLES

  

 

11 

  

Figure 3.  SUMMARY table 

Another example of a table is shown in Figure 4.  In this case, rather than showing 

percentages, Q has automatically chosen to compute the average (also known as the 

mean).  Q does this when the data is numeric rather than categorical.  Additionally, 

instead of showing a NET, the table now shows a SUM, which is literally the sum of 

the values in the table.
1
  When Q displays categorical data it shows a NET and when it 

displays numeric data it shows the SUM. 

 

Figure 4.  Comparison of means 

The two tables we have just looked at were both created by selecting a question in 

the blue drop-down with SUMMARY selected in the brown drop-down.  We can 

create a crosstab by selecting questions in both the blue and brown drop-downs (see 

Figure 5). The color-coding in the tables indicates statistical significance; with a blue 

color indicating that the numbers are significantly high and red indicating that they 

                                       

1
 SUM and NET are computed using observations for which there is complete data.  Where no respondents answered all the 

questions/items, SUM and NET will show NaN. 
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are significantly low. Arrows also indicate the statistical significance of the cells; the 

length of the arrow indicates the degree of statistical significance relative to the other 

cells in the table.  Significance can also be shown using font size.  See Tests of 

statistical significance, page 54, and the Q Reference Manual, for more detail. 

  

Figure 5.  Aided Awareness by BANNER 

Market research studies often contain two-dimensional questions.  For example, 

Figure 6 shows results from a question where consumers were asked to rate 

agreement with a series of statements.  It is “two-dimensional” because displaying the 

question requires both the rows and the columns. 

 

Figure 6.  Attitude data 
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Figure 7.  Attitude data – top 2 boxes 

With two-dimensional questions the only options available in the brown drop-down 

are RAW DATA and SUMMARY.  The trick to overcoming this is to manipulate the 

data so that the question is no longer two-dimensional.  Figure 7 shows an example of 

this, presenting the Top 2 box scores for the attitudes (i.e., the sum of Strongly agree 

and Agree a little; this can be setup in the Variables and Questions tab – see Worked 

Example 5: Setting Multiple Response Questions, page 48).  The Q Reference Manual 

and Online Training contain extensive detail on how to set and change question 

types. 

Worked Example 1: Creating tables 

 

Figure 8.  SUMMARY of BANNER 
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1. Click in the File menu and select Open Existing Project… 

2. Select Phone 1.Q, which will be in c:\Program Files\Q\Examples (unless Q 

has been installed in a different location on your computer).  
 

This project contains data on mobile phone ownership and usage. The table in 

Figure 8 shows the percentage of the sample in each category. For example, 60% 

of the sample is aged less than 35 years and 26% have Telstra as their current 

provider. 

3. Click on the blue drop-down and select Q6. Aided Awareness.  The resulting 

table shows the percentage of people who are aware of each of the mobile phone 

companies (e.g., 90% of people have heard of Optus). 

4. Click on the brown drop-down and select BANNER.  You have now created what 

is commonly known as a crosstab (see Figure 9). By default, this table is 

presenting column percentages (this is indicated at the top left of the table).  That 

is, the table shows the percentage of people in each demographic group (columns) 

who are aware of the mobile phone companies (rows). 

  

Figure 9.  Aided awareness by BANNER 
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The blue drop-down is used to select the question that will appear in the rows.  The 

brown drop-down is used to determine how you wish to break down the results of 

that question. Through the brown drop-down, you can choose RAW DATA (i.e., the 

underlying data used to construct tables), a SUMMARY of the information (e.g., the 

percentages in each category) or select another question to see the interrelationship 

between two questions.  If you have a two dimensional question, you will only get a 

choice between RAW DATA and SUMMARY.  If your data is text (e.g., verbatim 

responses from an open-ended question), you will only have the option of viewing it 

as RAW DATA, unless you change the Variable Type in the Variables and 

Questions tab or code the data (Insert Variable(s)Code TextNew Code 

Frame…). 

The red and blue coloring of numbers in tables can be used to quickly identify 

interesting results.  For example, Figure 9 shows that 46% of people aged less than 

35 years are aware of Virgin Mobile, while only 22% of those aged 35 years or over 

are aware of this brand. See page 54 for a more detailed discussion of significance 

testing. 
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Working with tables 

Q enables you to quickly and accurately modify tables to help you discover and 

present findings. This chapter provides an overview of the basics of using Q to 

manipulate tables. In this chapter you will learn how to: 

 Move and change rows and columns in tables. 

 Select different statistics to view (e.g., percentages, n, etc.). 

 Format the data. 

 Deal with missing values. 

 Format cells. 

 Create spans, grouping together rows or columns. 

 Create banner questions. 

 Customize the names of statistics on tables and plots. 

Moving and changing rows and columns 

When viewing any table, you can move rows and columns by dragging-and-dropping 

(i.e., click on the row or column of interest and drag it to where you would like it to 

be).  Merging is done in the same way, except that you drag one category on top of 

another and release your mouse button (i.e., ‘drop’ one category onto another).  

Figure 10 shows a new version of the table first introduced in Figure 6 (if you wish to 

reproduce this example, open Phone 1.Q which will be in c:\Program 

Files\Q\Examples and select q23. Attitudes in the blue drop-down).  It has been 

created by: 

 Copying the Strongly agree category and placing it immediately to the left of the 

original Strongly agree category (hold the Ctrl key down, click on the cell and 

drag – a small box appears saying “Copy”  when you are about to copy). 

 Copying the Agree a little category onto the copy of the Strongly agree category 

(i.e., while holding the Ctrl key down, dragging Agree a little onto the copy of 

Strongly agree and releasing when the box saying Copy Onto appears).  This 

resulted in a category called Strongly agree + Agree a little. 
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 Renaming Strongly agree + Agree a little as Top 2 Boxes (right-mouse click on the 

category, select Rename…, type the new name and press OK).  Note that 

there are other options available in this menu and also that the options 

available depend upon the data being shown. 

TIP: These three steps could have been done more quickly by selecting the 

two categories, right-clicking and selecting Create NET. 

 Sorting the table by right-clicking on Top 2 Boxes and selecting Sort By and 

Values – Descending. 

 Changing the widths of the columns and heights of the rows by dragging the 

lines in-between the rows and the columns (as is done in Excel). 

  

Figure 10.  Attitude data 
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If you inadvertently merge categories, you can unmerge them by clicking your right 

mouse button on the category and selecting Split or, if you wish the categories to 

appear as it did prior to editing, you can select Revert. 

Selecting statistics (n, Row %, Column %, etc.) 

Q has an expert system which automatically selects the most appropriate statistics to 

show on a table.  Most commonly, these are percentages and averages.  Alternative 

statistics can be shown within each cell, to the right of the table or below the table.  

These statistics can be selected by right-clicking on the table and selecting from 

within Statistics – Cells and, on some tables, also from Statistics – Right and 

Statistics – Below. 

The table on the left of Figure 11 shows column percentages. It is the default way 

that Q displays crosstabs of categorical questions. The table on the right shows the 

column percentages but also shows the count in each cell of the table, n. The second 

table was created by: 

 Creating the table on the left. 

 Right-clicking the mouse on the table and selecting Statistics – Cells and 

then n. 

 Pressing the  button on the tool bar, which displays a percentage sign next 

to any percentages.   

Note that the top-left of the table indicates the statistic(s) displayed on the table (e.g., 

Column %, n).  

    

Figure 11.  Unaided Awareness data with various statistics selected 
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Figure 12 shows a table where Average and n have been selected from Statistics – 

Right. 

 

 

Figure 12.  Attitude data with categories, averages and sample size shown 

Missing values 

Q automatically filters data that have been classified as missing values in the raw data 

file.  

To modify which values are automatically filtered, right-click on the blue or brown 

categories shown on the table, select Values… to open the Value Attributes dialog 

box, and ensure the appropriate categories are checked as Missing Data. 

Formatting cells 

You can increase or decrease the number of decimal places, show percentage signs 

and color the background of cells to highlight interesting results by using the 

formatting toolbar buttons ( ).  If you wish to set different numbers of 

decimal places for different statistics, right-click on the table, select Table Options…, 

click on the Decimals Places tab and set the number of decimals as desired.  If you 

wish to make these changes to every table, do this via Edit  Project Options…  

Decimal Places. 

 

Worked Example 2: Merging, Moving and Renaming Rows and Columns 

1. Click in the File menu and select Import New Data File (New Project)…. 

2. Select the Pasta Sauces including screenouts.sav data file which will be 

in c:\Program Files\Q\Examples (unless Q has been installed in a different 

location on your computer). 

3. Click Yes when Q alerts you that that your data has not been completely set up. 

4. Click on the blue drop-down and select Age. How old are you?  Your screen 

should now look like Figure 13. 
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Note that the brown drop-down has also changed and shows SUMMARY, which is 

the default when displaying everything that is not text. 

 

Also note that Q has colored the numbers on the table, using blue to highlight 

numbers that are relatively high and red to highlight numbers that are relatively 

low. In this case, each number is being compared to the average.  

  

Figure 13.  Frequency of age 

5. Right-click on the table, select Statistics – Cells and select n. 

6. Place your mouse on Less than 18.  Hold down your left mouse button down and 

drag onto 18 to 24.  Note that a small box appears saying Merge… or Move 

depending upon the location of your mouse pointer.  Release your mouse when 

the cursor is on 18 to 24 and the two categories are merged (with all the 

corresponding numbers automatically updated), and renamed as 18 to 24 + Less 

than 18. 
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7. Hold your Ctrl button down and use your mouse pointer to click on 18 to 24 + Less 

than 18, 40 to 44, 45 to 49, 50 to 54, 55 to 64 and 65 or more. 

8. Right-click on one of these categories and select Merge…. 

9. Type Other and press the Enter key on your keyboard. 

10. Click on the Other row category and drag it to in-between 35 to 39 and NET.  Your 

table should now look like Figure 14.   

  

Figure 14.  Table with merged and moved categories 

11. Right-click on the table, select Statistics – Cells and deselect n. 

12. Right-click on any of the row categories and select Revert, which restores the age 

categories to how they were before you moved them around. 

Spans 

Row and column categories can have one or more spans placed above them (see 

Figure 15).  To create spans, first select the headings of interest (holding down Shift 

or Ctrl and clicking with the left mouse button), then right-click and select Create 

Span….  Spans can be moved and resized by dragging and dropping. 

 

Figure 15.  Example of span 
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Creating Banner Questions 

It is often useful to combine multiple questions together so they can be selected 

simultaneously.  For example, Figure 16 shows a table where the brown drop-down 

contains a banner, which includes age and gender. 

 

 

Figure 16.  Example of banner question (shown at the top of the table) 

Such a banner is created by selecting CreateBanner… and dragging the questions 

of interest from the left to the right of the dialog box – see Figure 17.  Where 

questions are placed side-by-side, they will appear side-by-side in the resulting banner 

question.  If placed on top of each other, Q will nest the questions (e.g., create a 

category of Males aged 18 to 24). 

  

Figure 17.  Create Banner dialog box 
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More complicated banner questions can be created using the methods described in 

the Q Reference Manual. 

Some types of questions cannot be selected in the Create  Banner… dialog box.  In 

particular, you can only select questions that are Pick One or Pick Any.  See page 46 

and following for detailed information on the meaning of the different types and a 

worked example illustrating their uses; more information is in the Q Reference Manual 

and Online Training. 

Customizing the names of statistics on tables and plots 

It is possible to customize the names of statistics on 

tables and plots.  The table on the right has been 

customized to show statistics in the Chinese language. 

To customize statistics for an entire project, select 

Edit Project Options and click on the Output Text tab.  Enter the desired names 

in the Output Text column, as shown below. 

 

You can also change the text shown for selected tables by selecting Edit Table 

Options, clicking on the Output Text tab and making the changes.  
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Weighting 

Weights are applied in the Weight drop-down at the bottom of the screen.  Different 

weights can be applied to different tables in a project.  Press  to remove a weight. 

In addition to the drop-down, the presence of weighting is also reflected in the 

sample size description at the bottom of the screen.   

base n = from 151 to 215; total n = 223; 72 missing; effective sample size = 156 (70%); 80% filtered out 

Figure 18.  Sample size description with weighted data and a filter 

The description in Figure 18 indicates that: 

 The sample size varies for different cells in the table, the cell with the smallest 

sample size being 151 while the largest cell has a sample size of 215.  (We can 

see each cell’s sample size by selecting Base n from Statistics – Cells  – see 

Selecting statistics (n, Row %, Column %, etc.), page 18). 

 The total sample size of the table is 223 (i.e., if there were no missing data, 

each cell would be based on a sample size of 223). 

 Each cell has up to 72 missing values (i.e., 223 minus 151). 

 The effective sample size is 156 (this is computed on the largest base n of 

215).  In most instances, weighting causes a decrease in the statistical 

significance of results.  The effective sample size is a measure of the precision 

of the survey (e.g., even if you have a sample of 1,000 people, an effective 

sample size of 100 would indicate that the weighted sample is no more robust 

than a well-executed un-weighted simple random sample of 100 people).  

 The weighted sample size of 223 has the same precision as an un-weighted 

sample of 70% the size (i.e., 156 / 223). 

 The percentage shown in brackets indicates the ratio of the effective sample 

size to the total sample size.  A score of 100% indicates that the weighting has 

caused no loss of precision. 

 The final statistic (80% filtered out) shows the proportion of the total number 

of observations in the study that is not available for the analysis due to a filter 

having been applied to the table. 
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Weights, sample size and population 

In commercial market research, weights generally have two roles: to correct for bias 

in the sampling (e.g., over-representation of a particular segment) and to gross up 

the sample size to match known population totals (e.g., the number of people in a 

country).  Q accommodates both of these roles.  When a weight is applied, all 

percentages and averages automatically take the weight into account.  Estimates of 

the population size can be obtained by selecting Population from Statistics – Cells, 

Statistics – Below and Statistics – Right. 

Making variables available as weights 

Any variable in the data file with the name of weight will 

automatically be available as a weight. 

Any non-text variable can be used as a weight by right-clicking on 

the variable in the Data tab and selecting Available for 

Weighting.  Alternatively, check the weight tag in the Variables 

and Questions tab ( ).  This makes it appear in the weight drop-down at the 

bottom of the screen in the Tables tab. 

Any numeric or categorical variable can be automatically recoded 

as a weight using the target weighting method by: 

 Selecting the variable in the Variables and Questions tab and pressing the 

Values button ( ). 

 

Figure 19.  Value Attributes dialog box with Show weights selected 

 Ticking the Show weights checkbox.  This causes two additional columns to 

appear: Current Sample Size and Population Target.  The Current Sample 

Size shows the number of observations currently in each category (e.g., in 

Figure 19, 339 respondents are Male).   

 Entering the desired population sizes in Population Target cells.  When the 

values of Population Target are changed, the corresponding Value also 

Automatic 

Tagging 

variables as 

weights 

Creating a 

target weight 
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changes (to the value of Population Target ÷ Current Sample Size).  Auto-

update causes the values of Population Target and Value to be updated such 

that if the variable is used for weighting, the weighted sample size 

(Population) will be equivalent to the un-weighted sample size (n). 

 Press OK and tag it as being available for weighting ( ). 

Multiple variables can be used to construct a weight by: 

 Following the procedure for target weighting for each variable that you wish to 

use to construct the weight. 

 Select all the variables. 

 Click the right button on your mouse and select Insert Ready-Made 

Formula(s) and Rim Weight/Rake. 

Rim weighting 
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Filtering 

It is often useful to view data for only a subset of a sample of respondents – this is 

called filtering.   

In this chapter you will learn how to: 

 Create a simple filter. 

 Create a complex filter. 

 Quickly create lots of filters. 

 Apply a filter. 

 Remove a filter. 

Creating simple filters 

 

 

Figure 20.  Selecting cells for filtering 
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To create a simple filter: 
 

 Create a table which shows the data you wish to use to construct the filter.  For 

example, to filter the data to base analyses on only Males aged 25 to 44, you 

should select age and gender in the blue and brown drop-downs.   

 Select the cells representing the respondents you wish to include in the filter.  

For example, to filter males aged 25 to 44 select the cells as shown in Figure 20.  

 Press the Create new filter button ( ). 

 Enter your desired name for the filter.  It is a good idea to give filters names 

that will be easy to recall and will be meaningful to others using Q or reading 

tables and charts generated by Q (e.g., Males 25 to 44 is a good name for this 

filter). 

 If you do not want the filter to be applied to the table you are viewing, ensure 

that Apply filter to the current table is not checked in the dialog box. 

 Press OK.   

 

 

Figure 21.  Table with filter applied 

Figure 21 shows the table with the filter applied, with NaN in many of the cells not 

included in the filter.  NaN means Not a Number; in this instance, the females have a 

sample size of zero after applying the filter so percentages cannot be computed. 
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However, zeros do appear in the column for males as the total sample for men is still 

greater than zero. If we now change the variables in the brown and blue drop-downs, 

the filter will remain selected.  

Creating complex filters 

More complex filters can be created by: 

 Applying multiple filters to a table.   Each time you apply a filter to a table 

using a filter menu at the bottom of the Tables tab, another filter menu will 

appear to its right so that you can easily apply further filters to the same table 

(in Figure 21 the first filter is Males 25 to 44, followed by AND with a second 

filter menu showing Total Sample). 

 Using existing variables as filters.  Any variable can be made available as a 

filter by either clicking on the Filter tag in the Variables and Questions tab (

).  You can also right-click on the variable name in the Data tab and 

selecting Available for Filtering. 

 

 Constructing new variables as filters.  This is discussed in more detail in the Q 
Reference Manual and Online Training.  The fastest way to do this is to 

create a new filter in the standard way, apply it to a table, click the yellow  

to the left of the first filter drop-down menu, right click on the highlighted 

variable and select Edit Variable…. 

 

Quickly create lots of filters 

You can quickly create lots of filters as follows: 

 Create a Banner question, selecting all the questions that are wanted as filters 

so that they are side-by-side (see Creating Banner Questions, page 22). 

 Press , to the right of the blue dropdown menu (which should have the 

newly-created banner question selected in it).  This causes the variables in the 

banner question to be selected in the Variables and Questions tab. 

 Make all of the selected variables available as filters by pressing clicking on the 

Filter tag ( ).  It may also be useful to hide this question (press ) so 

that it does not appear in any dropdown menus. 

 Review the Label column of the selected variables if you wish to reword the 

descriptions of any filters. 
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 Right-click on any variables with the word NET appearing in the label and select 

Delete Copied or Constructed variable(s) (as having a filter which is a NET 

makes no sense, as it will be 100% of the sample).  

Applying filters 

Once a filter has been created, it can be applied to any table using the Filter drop-

down on the bottom left of the screen. 

There are two ways of seeing that a filter has been applied.  First, the drop-down 

displays the name of the filter with a green background.  Second, the description of 

the sample size at the base of the screen also shows whether or not a filter has been 

applied (see Figure 18, page 24).   

Removing a filter 

To remove a filter, go to the Filter drop-down and select Total sample or press . 
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Creating reports 

This chapter provides an overview of how to produce reports of your findings.  In this 

chapter you will learn how to: 

 Create a report, which is simply a collection of tables that you want saved.  

 Organize a report. 

 Lock tables so that they cannot be accidentally changed. 

 Change multiple tables at once. 

 Automatically generate reports. 

Saving tables 

Each project contains a Report  into which tables are saved.  A report is a collection of 

tables that you can view at a later time. An example of a report (containing 4 tables) 

is shown in Figure 22.  If not already visible, a report can be viewed by positioning 

your mouse over the left border of the screen until the arrow turns into a double-

headed arrow with a line through it, then holding your left mouse button down and 

dragging the border out until your screen looks like Figure 22. The left of your screen 

will display the Report.   

  

Figure 22.  A report containing one table 
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To add a table to the report, press the  button to the top-left of the table.  This 

saves the current table and adds a new table immediately beneath it in the report.  

The new table, which is a copy of the saved table, is now displayed.  The highlighted 

table in the Report indicates which table is being viewed. 

Organizing reports 

By right-mouse-clicking anywhere on the report you obtain a menu that you can use 

to create Groups (i.e., folders to organize your report), delete tables and rename 

tables.  Similarly, you can drag and drop tables and groups of tables to reorganize the 

report. 

Locking tables 

Often it is useful to lock a table to prevent users from inadvertently modifying it by 

formatting it or changing the selections in the blue or brown drop-downs, the weight 

menu or the filter menu.  This is done by right-clicking on the table in the Report and 

selecting Lock from the menu.  To unlock, simply right-click on the table again and 

select Unlock. 

If the data is modified, either by importing new data, recoding data or merging 

together the same questions in a different table, the data shown in the table will 

change irrespective of whether the tables are locked or not. 

Multiple selections 

You can use your Shift and Ctrl keys in conjunction with your mouse to 

simultaneously apply operations across multiple tables at any one time (e.g., applying 

weights and filters, selecting questions, setting footers, locking, printing and selecting 

statistics). 

Hiding the Report 

Position your cursor above the gray border between the table and the report and, 

when the double-ended arrow with the line through it appears, drag the slider so that 

the report is no longer visible (it will automatically re-appear whenever you open a 

project containing more than one table). 

Worked Example 3: Creating reports 

1. Click in the File menu and select Open Existing Project… and open Phone 1.Q, 

which will be in c:\Program Files\Q\Examples (unless Q has been installed 

in a different location on your computer). 
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2. Select Q6. Aided Awareness in the blue drop-down, and BANNER in the brown 

drop-down. 

  

Figure 23.  The Report Tree 

3. Press the  button to the top-left of the table.  You will see that the Report on 

the left of the screen (see Figure 23) shows two separate tables, which at the 

moment are identical; they are both showing Q6 by the banner question. 

4. Click in the blue drop-down, type q4 and select q4: Age.  Note that the second 

table in the Report has now changed to show q4: Age by BANNER.   

5. Click on the first table in the tree.  Observe how we are now viewing Q6. Aided 

Awareness in the blue drop-down again. 

6. Position your mouse over q4: Age by BANNER in the Report.  Right-click and select 

Lock.  A padlock will now appear in the Report next to the table – once a table is 

locked it cannot be changed by the user. This prevents accidental changes to 

tables (but note that table content will still change if data or any question/s shown 

in the blue or brown drop-downs are modified elsewhere). 

7. To unlock the table, right-click again over it in the Report and select Unlock.  

8. Right-click on Report. This time, select Add Group. Q has created a subfolder 

called Group 1 into which you can organize various reports. 

9. Change the name of this group to Awareness. You can add to tables to groups by 

dragging and dropping the tables into the group subfolder.  

 

Basic Tables 

Basic Tables is a feature for automatically generating a Report containing a large 

number of tables. 

Basic Tables are created as follows: 

 Select Basic Tables… from the Create menu. 
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 Select the key questions of interest as Key questions.   

 If you want to cross-tabulate these questions by other profiling questions (e.g., 

by age and gender), select these other variables as Profiling questions. 

 Press OK. 

 If you wish the tables to contain non-default statistics, select the tables in the 

report and then select the desired options. For example, a table of last brand 

consumed by age group will, by default, only show column percentages; if you 

wish your table to show percentages and counts you would check each of n, 

Row % and Column %. 

These tables can then either be viewed directly in Q, exported to Word, PowerPoint or 

Excel ( ), printed or exported as a PDF (File  Export to PDF…). 

Making notes 

Notes about a project can be stored in the Notes tab (see the bottom left of the 

screen).   

Notes about a specific table can be stored with the table by right-clicking, selecting 

Table Options… and entering the notes in the Notes box. 

Notes can be attached to individual variables in the Variables and Questions tab by 

right-clicking on the variable and selecting New Comment for Variable…. 
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Plots 

This chapter provides an overview of how to create plots in Q.  Q can also create plots 

using Excel, Word and PowerPoint, as described in Export to Office (see page 32).  

Creating a plot 

A table is turned into a plot, and vice versa, using the 

dropdown shown on the toolbar, as shown to the right.  The 

main plot types are shown in Figure 24. 

Modifying a plot 

If you wish to merge categories or rename categories in a plot, first change it back 

into a table and make the desired changes. 

A plot is formatted by right-clicking on the part of the plot you wish to change and 

selecting from the available options.  If you want to change the appearance of a 

specific part of a plot, such as changing a series from a line into columns, first select 

the relevant part of the plot (by left-clicking) and then right-click to see the available 

options.  For example: 

 To change the font of an axis, click on the axis, right-click and select Format 

axis…, and then click on the text that says  Gridlines are also 

added in this dialog box. 

 To add the values to a plot for a series, right click on the bars/lines of the 

series, select Format Data Series… and check Label points. 

 To specify which date periods are to be included in the columns of a Column 

plot with trend, right-click on the columns and select Set Categorical 

Periods…. 

 To turn a column plot into a snake plot, create a Bar/column/line plot, right-

click on it and select Swap X and Y Axes, right-click and select Format Data 

Series… and change the Plot type from Column to Line. 

 When creating a Stacked column/bar plot, the position of the bars relative to 

the axis is determined by the Value (which is set by right clicking on the 

relevant categories in a table and selecting Values…).  Positive values appear 
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above the axis, negative below and 0 values are shown in a separate table 

underneath the plot. 

Additional information about the Time series plot, Column plot with trend and Trend 

plot is in the Q Reference Manual. 

Standardizing the look and your plots 

Select Edit  Project Options  Plots to set default colors and fonts.  You can drag 

a plot from one project to another and it will remember its formatting (note that if you 

are using the default colors, the plot will apply the default colors of the new project). 

 
Bar/column/line plot 

 

 
Column plot with trend 

 
Grid of bars 

 
Histogram 

 
Scatterplot 

 
Stacked column/bar plot 

Time series plot 
 

Trend plot 
Figure 24.  Plot types 
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Generating outputs 

This chapter provides an overview of different ways of producing outputs using Q.  In 

this chapter you will learn how to: 

 Copy a table. 

 Print tables. 

 Create PDF files of tables. 

 Export a table or chart to a Microsoft Office application. 

Copying a table 

Press the Copy Table to Clipboard toolbar button, , which copies the table into 

Windows’ clipboard, from which it can be exported into other programs (this approach 

remembers no formatting and is generally only useful if the data is to be plotted or 

reanalyzed in another program).  

Printing tables 

Select the table or tables in the Report which you wish to print and select Print… 

from the file menu. 

Tables can be previewed using File  Print Preview.   

There are a variety of ways to modify the appearance of printed documents: 

 Margins and paper sizes can be set in File  Page Setup…. 

 Formatting options for the screen, exporting and printing are controlled using 

styles, which are modified at Edit  Project Options…  Table Styles. 

 Heading fonts, font styles and font sizes in printed documents and PDFs are 

modified at Edit  Project Options…  Printed Headings. 

 A cover page can be created in Edit  Project Options…  Printed Cover 

Page. 

 Headers and footers can be set in Edit  Project Options…  Printed 

Header/Footer.  Footers for individual tables can be set by right-clicking on the 

table and selecting Table Options…. 
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Export to PDF 

Tables and plots can be exported as Adobe Acrobat PDF files (.pdf) by selecting 

them and then selecting File  Export to PDF....   The table will be exported in 

accordance with the options that apply for printing (see the previous section). 

Export to Office 

Tables and plots can be exported to Microsoft Office by right-clicking on tables in the 

Report and selecting Export to Office or by pressing the appropriate toolbar button (

).  This causes the Table Options dialog box to appear.  The following 

options are available and are also remembered when you next export the tables:  

 Name: The name or title is read from the Report, which is in turn created by 

default from the contents of the blue and brown drop-downs (and, it is reset 

whenever the blue and brown drop-downs are modified). 

 Format: Several format options are available for exporting to Excel, Word and 

PowerPoint. 

 Chart: Several format options are available for exporting to Excel, Word and 

PowerPoint.  If using Office 2007 or Office 2010 you can select any Word, Excel 

or PowerPoint chart templates you have created from this menu; consult the Q 

Reference Manual for details on using charting templates with earlier versions 

of Office. 

 Styles: Several format options are available for screen display, print format, 

export to PDF and export to Office. This tab can be used to customize formats 

for the specified table, overriding any project-wide defaults. 

 Decimal Places: This tab permits you to customize the number of decimal 

places for different types of statistics. 

 Footer: By default, the footer is the description of the filter, weight and sample 

size and is shown at the bottom of the screen (see Figure 18, page 24).  

However, you can customize the footer in this tab.  Note that the text in the 

triangular brackets (e.g., <n>) will be computed based on the data in the table.  

At the bottom of the dialog box there is a text box preview of how your footer 

will look in the exported table.   

 Restore: this will restore all of the fields in this dialog box to their default 

values (i.e., their state prior to changes being made). 
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When multiple tables are being exported, many of the fields will be blank (because 

they will be different for different tables).  Some patience is required when exporting 

batches of tables: this may take a few minutes and can appear to have “crashed” 

even when it has not.  

Additional options for controlling the placement and formatting of objects when 

exporting to PowerPoint are contained in Edit  Project Options…  PowerPoint 

Export Layout.   

Worked Example 4: Exporting charts and tables 

1. Open Phone 2.Q, which will be in c:\Program Files\Q\Examples (unless Q 

has been installed in a different location on your computer). 

2. In the blue drop-down, select Fit (out of 100). 

3. Select Gender in the brown drop-down. 

4. Press  to copy the table to the report. 

5. Right-click on Fit (out of 100) by Gender in the Report and select Export to 

Office (alternatively you can click on the relevant button in the toolbar 

 ). 

6. Select To PowerPoint as Excel Chart in the Format drop-down menu and 3D 

Column Clustered in the Chart drop-down menu.    

7. Click OK. 

8. PowerPoint will now open with the chart you exported in it. Edit the chart as you 

normally would edit an embedded Excel chart in PowerPoint (you can directly edit 

it in PowerPoint or open it up in Excel). 

Updating presentations 

If you attempt to export to an office document into which you have previously 

exported, Q will ask: 
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By selecting Update This Presentation, Q replaces the existing data in the 

presentation with new data and updates any plots accordingly. If the plots are Q 

plots, they are redrawn to best utilize the space available in PowerPoint.   

If you are updating cells in an Excel spreadsheet that does not contain a plot (i.e., 

when exporting to PowerPoint as Excel WorkSheet) you may need to edit the 

worksheet and resize it to ensure that all cells are visible. 
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Creating dashboards 

Q can be used to quickly create dashboards.  A Q Dashboard is a project created in Q 

and then uploaded onto the ‘cloud’.  In this chapter you will learn how to: 

 Prepare a project for use as a dashboard. 

 Insert images. 

 Upload a project. 

 Manage the dashboard, company and users. 

 

Preparing a project for use as a dashboard 

Any Q project can be used as a dashboard.  By default, groups of tables and plots 

(i.e., folders) appear as tabs in a dashboard.  Any tables or plots that are not in a 

group will not be visible. 

If you have groups appearing within 

other groups, such as is shown to the 

left, then they will appear as nested tabs 

in the dashboard (as shown on the right.   
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You can hide a group so that it does not appear in a dashboard by putting the word 

private at the beginning of its name (e.g., private Weighting tables). 

If you wish to have some tables or plots grouped together such that they are 

surrounded by a border by putting them into a group and adding the word group to 

the beginning of the group’s name (e.g., group Brand health). 

The fastest way to quickly prepare a dashboard is to create lots of tables using Create 

 Basic tables… (see page 33) and then select all of these tables in the Report tree, 

changing them from a table to the plot type Grid of bar plots (see page 35). 

The most straightforward approach to creating filters for a 

dashboard is described in Creating simple filters (page 27).  If you choose to create 

filters in another way, it is important that any filters that require an OR operation 

(e.g., 18 to 24 OR 25 to 34) are contained within the same Pick Any question and 

share a span (this occurs by default when you used the method approach described in 

Quickly create lots of filters, page 29). 

Inserting images 

Sometimes it is useful to insert images into a dashboard, such as plots from other 

programs and PowerPoint slides saved as pictures (e.g., saved as GIF files). 

Images are inserted into a Q project by selecting Create  Image… and selecting the 

desired image.  These can be changed by pressing Swap Image…. A hyperlink can be 

created for the image by selecting Edit  Image options… and filling in the 

Hyperlink field. 

Uploading a project 

Upload a project onto a dashboard by selecting FileShare as Dashboard and 

following the prompts.  You can layout the images on the tab by clicking on them and 

dragging.  Press  to save the layouts. 

Managing the dashboard, company and users 

When viewing a dashboard press Manage dashboard to set and view basic settings for 

the dashboard and press Company settings to set and view settings for all your 

dashboards (e.g., to setup additional login details for other users). 

Filters 
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Data manipulation and preparation 

This chapter provides an overview of different types of questions that can be analyzed 

in Q and alternative ways of manipulating and preparing data.  In this chapter you will 

learn about: 

 Viewing and exporting raw data. 

 Editing raw data. 

 Creating new variables. 

 The different types of Questions used by Q 

 Setting question types. 

 Changing question types. 

 Advanced ways of constructing variables. 

Reviewing summary statistics 

Pressing  on the Variables and Questions tab toggles on and off columns 

containing the minimum, mean, maximum and sample size for every variable. 

Raw data 

The underlying data of any question can be viewed by selecting the question in the 

blue drop-down menu and selecting RAW DATA in the brown drop-down menu.  This 

can be copied into other programs. 

Alternatively, variables can be exported into Excel by selecting the relevant variables 

in Variables and Questions and selecting File  Export Selected Variables to 

Excel.... 

The Data tab 

All the underlying data for a project can be viewed by clicking on the Data tab at the 

bottom left of the screen – see Figure 25.  Each row represents the data for a 

respondent.  Each column represents a variable, with the Name of each variable 

shown at the top.  The black lines above the variable names indicate how the 

variables are grouped into questions (these groupings can be changed in the 

Variables and Questions tab – see Setting questions, page 48). 
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Figure 25.  Data tab 

If a cell in this tab is clicked, it is shaded light blue and the rest of the row is shaded 

dark blue.   

In order for Q to remember any data changes you make, you first 

need to select a variable that contains a unique identifier for each respondent, such as 

the respondent ID.  Q will use this if your raw data file changes, thereby ensuring that 

your work is retained even if you update your data. Select this unique identifier using 

the Case IDs drop-down at the top left of the screen. 

When a filter is applied the selected rows are shaded green. 

Right click on a column header and select Sort Data by This 

Column to sort by that column.  Alternatively, select Sort… from the View menu to 

sort by more than one column.  To remove all the sorts: select View  Sort… and 

Delete Level. 

Tick the Show labels checkbox at the top right of the screen to 

show the Value Labels instead of the values in each cell. 

You can change the data by clicking in a cell and typing a new 

value into the cell, or, by changing the data shown in the formula 

bar at the top of the screen.  This is only a good approach when correcting errors – 

recoding of data is better done using various procedures in the Variables and 

Questions tab.  See Setting questions, page 48, and the Q Reference Manual for 

more detail. 

Case Identifiers 

Filtering 

Sorting 

Value Labels 

Editing the 

data  
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Hover your mouse over any cell and a tool-tip will appear showing original values, 

labels, etc. 

New variables can be created using other variables by right-clicking 

on one of the variable names, selecting Insert Variable(s)  

Excel-Style Formula and either Numeric or Text.  If you require any statistical 

analysis, then you should select Numeric.   

As the name suggest, Excel-style formulas in Q are basically the same as formulas in 

Excel.  Each formula begins with an equals sign.  Formulas may contain text, numbers 

or variable names.  The variable names can be either typed into the formula or 

selected by clicking on the variable names.  When a formula is complete, press Enter 

or press .  To cancel, press Escape or press .  Examples of formulas: 

=Q2+Q7 

=1-AVERAGE(Q3,Q4,Q5) 

=IF(Q1="M", 1, 2) 

 

Look up Excel-Style Formula in Help  Data Tab for a full list of the functions that 

can be used in formulas. 

Warning: In Excel, blank cells are ignored by most formulas.  In Q, a blank cell in the 

Data tab represents missing data, and many formulas will return a NaN if they refer to 

the cell (e.g., SUM). 

A more powerful, but more complicated, approach to creating new variables involves 

the use of JavaScript – see the Q Reference Manual for more detail. 

To find a specific variable, select Edit and Find Variable….  You 

can identify the variables and values used to construct any question by right-clicking 

on a category of a table selecting Show Variables and Values.... 

In general, the best way of inserting additional variables into a 

project is to modify the data file and re-import the data file (see 

Updating tables with new or revised data, page 52).  However, it is possible to insert 

new variables by right-clicking on one of the variable names and selecting Insert 

Variable(s)  Paste Data (e.g. From Excel). The number of entries you paste must 

match the number of cases in the raw data file.   

Right click on the row and select Delete Row.  This takes a 

surprisingly long amount of time as Q checks the consequences of the deletion on 

every variable and every table in a project, so it is often better to create a new filter 

and, in the Data tab, apply the filter, then right-click and select Delete Rows 

Creating new 

variables 

Find Variable 

Inserting 

variables 

Delete cases 

mk:@MSITStore:C:/q/Flip/bin/Debug/Q.chm::/Excel-Style%20Formulas.htm
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Matching Filter (Green).  If deleting large amounts of data, it is often advisable to 

delete them in the data file. 

Click and drag the short vertical line at the end of the horizontal 

scroll bar at the bottom of the screen. This splits the sheet so that you can 

simultaneously view the data of non-adjacent variables. 

Question Types 

The way that Q presents data is determined by the underlying Question Type of the 

data.   

Question Type Description Example 

Text Each observation in the 

data file contains text. 

What is your name?  

_____________ 

Text – 
Multi 

Multiple related fields 
of text for each 

observation in the data 
file. 

Please type in the names of 
your three favorite soft drinks 

 

1.____  2. ____  3.____ 

Pick One A set of mutually 
exclusive and 
exhaustive categories 

(i.e., nominal or ordinal 
scales). 

Are you... 
 
Male  Female 

Pick One – 
Multi 

A series of Pick One 

questions sharing the 
same scale points. 

Please rate your satisfaction with the 

following banks 

  Low Med High 

Westpac    

ANZ        

St George    

Number A numeric variable 
(i.e., interval or ratio 
scale). 

How many glasses of wine did you drink 
last night? ____  

 

Number – 
Multi 

A series of numeric 
variables measured on 
the same scale. 

Next to the brands below, please indicate 
how many times you have purchased 
them in the past week 

Coke ___ Pepsi ___ Fanta ___ 

Splitter 
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Number – 
Grid 

A question requiring 
numeric responses, 

where the variables 
can be thought of as 
being ordered in two 

dimensions (e.g., a 
Number – Multi 

question asked in a 
loop).  

In the past month, how many economy 
flights did you take on... 

Qantas ___  United ___ SAS ___ 

In the past month, how many business 
class flights did you take on... 

Qantas ___ United ___ SAS ___ 

Pick Any 

 

What is usually 

referred to in market 
research as a multiple 
response or multi 

question.  Respondents 
are asked to pick all 
that apply from a list of 
options.   Pick Any – 

Compact is question 

type that contains the 
same information, but 

stored in a more 
contact format (see the 
Q Reference Manual). 

Which of the following have you bought in 

the past week? 
 

 Coke  Pepsi  Fanta 

Pick Any – 
Grid 

A set of binary 
variables that can be 

thought of as being 
ordered in two 
dimensions (e.g., a 
Pick Any question 

asked in a loop). 

Which of these brands are cool? 
 Coke  Pepsi   Fanta  

 
Which of these brands are young? 
 Coke  Pepsi  Fanta 

 
Which of these brands are sexy? 

 Coke  Pepsi  Fanta 

Date  A question containing a 
date. 

What is your date of birth? 

 ____ / ____ / 19____ 

Ranking Multiple numeric 
variables that represent 
a ranking, where the 

highest number is most 
preferred and ties are 
permitted. 

 

 

Rank the following brands according to 
how much you like them... 

 Coke ____Pepsi ____   Fanta ____ 
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Experiment A Number, Number – 

Multi, Ranking, Pick 

One or Pick One – 

Multi question, where 

the alternatives 

presented were varied 
using an experimental 
design. 

Which of these would you buy? 
Coke 

$2.00 

Can 

Pepsi 

$4.20 

Bottle 

Fanta 

$3.20 

Flask 

 

Setting questions 

Questions may consist of one variable (e.g., age) or multiple variables (e.g., aided 

awareness of multiple brands).  Q is structured around questions and it automatically 

takes into account the different types of questions.  However, often data files are not 

well set up and it is necessary to inform Q as to which variables should be combined 

to form questions. 

You can instruct Q to turn sets of variables into questions using the Variables and 

Questions tab, located on the bottom left of the screen.  An example is shown in 

Worked Example 5.  The Q Reference Manual and Online Training contain many 

other methods for constructing different types of variables and questions, including 

binary variables, categorical variables, text variables and coding of text variables. 

Worked Example 5: Setting Multiple Response Questions 

1. From the File menu select Import New Data File (New Project)... and select 

Phone.sav, which will be in c:\Program Files\Q\Examples (unless Q has 

been installed in a different location on your computer). 

2. Click No when asked if Q should automatically set up the file (ordinarily, one 

should select Yes). 

3. Click on the Variables and Questions tab (bottom left). 

4. Select rows 7 to 17. 

5. Right-click and select Set Question....  Note that Q has made an educated guess 

about the name of the question and the appropriate Question Type, both of 

which can be changed by the user. 

6. Press OK.  Note that for this question only the first row of the Question column is 

in bold; the rest are in grey, indicating that they are all part of the same question.  

The Status column will be marked as Check, in yellow, which is Q’s way of 

informing that it has made some assumptions about which values should be 

X 
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counted (e.g., to count the 1s).  These assumptions can be checked by clicking the 

down-arrow to the right of the word Check, or by clicking the Values button (…), 

and reviewing the selections in Count This Value. 

7. Double-click on one of the row numbers of the newly created question and you will 

see a summary table of the newly created multiple response question (Q refers to 

such questions as being Pick Any). 

8. Go back to the Variables and Questions tab. 

9. In the Find box at the top of the screen enter q23, which causes Q to scroll down 

to the first row containing this search term. 

10. Select rows 207 to 231. 

11. Right-click and select Set Question... .  A message will appear, warning that the 

variables are fundamentally different (the reason for this is explained below). 

12. Click Yes and change the question name to Attitudes.  Note that this time Q has 

determined that the Question Type is Pick One – Multi.  

13. Press OK and click on any one of the Values buttons, clicking Yes when again 

warned that the variables are “fundamentally different”.  Your screen should now 

look like Figure 26. 

14. Figure 26 reveals that the data is ‘messy’, with values of 6 and 22 being included 

without any labels (it was this that prompted the earlier warnings).  Check as 

Missing Data each of 6, DON’T KNOW and 22 and press OK. 
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Figure 26.  Value Attributes dialog box 

15. Double-click on one of the row numbers of the newly created question to see a 

summary of the question in the Tables tab. 

16. Right-click on any of the row or column headings and select Duplicate Question, 

which takes a copy of the question. 

17. Press OK to continue using the name Q has selected for this question. 

18. Press the  button to the right of the blue drop-down menu.  This automatically 

takes you to the Variables and Questions tab and selects the question being 

viewed. 

19. Rename the question by entering Attitudes – Top 2 boxes into any of the cells in the 

Question column. 

20. In the Question Type column, change Pick One – Multi to Pick Any.  

21. Click on the Values button, select Yes twice and ensure that the only categories 

checked as Count This Value are Strongly agree and Agree a little.  

22. Press OK and click on the Tables tab to review the question.  The table is now 

showing the top 2 box percentages. 

23. Press the  button to the right of the blue drop-down menu.   

24. Rename the question by entering Attitudes – Out of 100 into any of the cells in the 

Question column. 
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25. In the Question Type column change to Number – Multi.  

26. Click on the Values button, select Yes and change the Values so that from 

Strongly agree through to Strongly disagree have values of 100, 50, 0, -50, and -100. 

Press OK. 

27. Double-click on the row numbers to view the resulting table on the Tables tab.  

Note that the table is now showing averages. 

Undoing a question 

Sometimes a question will have been set up in such a way that it is not 

clear what the question means.  You can view the original variable 

labels (the source labels read from the raw data file) in the Variables and Questions 

tab by pressing  in the toolbar, which causes a new column, Source Label, to 

appear between Name and Label.  

To change variable labels back to their original labels, right-click on the variables of 

interest and select Revert to Source Label (this option will only appear if the Source 

Label and the Label are different).  To undo the setup of a question in entirety, 

select all variables in the question, then right-click and select Revert to Source. 

Requires Q  
Professional 
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Sharing and updating projects 

Sharing projects 

You can share projects with others by using the Send Pack function in the File 

menu.  A Q Pack uses the file extension .QPack, and is made up of the raw data file 

(.sav or .csv) and the Q Project File that contains the data manipulations and 

analysis.  The .QPack file has automatically been compressed to allow easy transfer.   

There are two options available within Send Pack: 

 Via E-Mail…: Selecting this option will create a new e-mail in your default e-

mail program.  The .QPack file will automatically be attached to the newly 

created email, leaving the fields blank for you to fill in. 

 Save as File…: This option allows you to save the .QPack file to a chosen 

location on your computer. 

As long as the user who receives the pack has Q installed, they will be able to double-

click on the file to open the project.  If the user chooses to save the project using 

Save Project or Save Project As… in the File menu, they will be advised that Q 

must break the pack into two separate files; a Q Project File and a raw data file (.sav 

or .csv).  The .QPack file will then be separated and the two files will be saved 

separately. 

Updating tables with new or revised data 

A report will automatically update whenever you make changes to the underlying 

data, for example by importing a new data file.  You can update any report with new 

or revised data by selecting Import Updated Data File (Current Project)… from the 

File menu. 

If the updated data file does not contain variables that have been used to construct 

other variables and filters in the Q project, Q will alert you by marking the “broken” 

variables with an INVALID Variable Status; an example is shown in Figure 27.  The 

drop-downs can be clicked on to obtain more information about the problem.  If you 

are happy to proceed with importing the updated data, press Accept and review the 

contents of the Status column on the Variables and Questions tab. 
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Figure 27.  Data Difference Warning example 
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Tests of statistical significance 

Q automatically highlights statistically significant results with font color and arrows.  

By default, results that are significantly high are shown in blue and results that are 

significantly low are shown in red.  For example, Figure 28 shows that respondents 

under 25 are more likely to be in the Optus category than respondents not under 25 

(and, equivalently, Optus respondents are relatively more likely to be under 25 than 

are non-Optus respondents). 

  

Figure 28.  Significance testing example 

Using ‘traditional’ tests of statistical significance 

The default tests of statistical significance employed in Q are conservative, which 

means that they are designed under the assumption that it is much better to say 

nothing at all than to report a result that has a non-trivial chance of not being found if 

the study were repeated.  To use the traditional approach to significance testing used 

in market research – which is not recommended – select EditProject 

OptionsStatistical Assumptions… and select Traditional (planned) as the 

Multiple comparisons method (the recommended method is False Discovery 

Rate).  An explanation of the different methods is contained in the Q Reference 

Manual. 

You may also specify different assumptions only for selected tables or plots by 

selecting EditPlot/Table OptionsStatistical Assumptions…. 

Column comparisons (pairwise comparisons) 

Statistical tests comparing differences between columns using letters are available by 

right-clicking on a table and selecting Statistics – Cells and Column Comparisons.   
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Planned tests of statistical significance 

The automated significance tests in Q (i.e., font color and arrows) are all tests 

comparing a single cell with the rest of the table.  Sometimes, it is interesting to 

conduct tests of multiple cells.  For example, we may wish to know whether, overall, 

there is a relationship between age and brand in Figure 28.  To conduct such a test 

we highlight all the cells in the table and press the  button, which automatically 

selects an appropriate significance test and performs this test on any cells selected in 

a table.  Similarly, if we only wish to test a proportion of the table, (e.g., to assess if 

Telstra customers are of a different age distribution to Optus customers) select the 

cells of interest and press .  It is always essential to review the Null 

hypothesis to ensure that the test that Q has conducted is the one that you would 

consider to be appropriate.   

Statistical testing with weights 

Q uses weighted data when computing significance tests.  On most tables, a weight is 

taken into account using Taylor series linearization.  In other instances, the weight is 

scaled so that its sum equals the effective sample size.  More detail is provided in the 

Q Reference Manual. 

Q can also weight the data in accordance with the standard approach used in most 

market research software; this is done by selecting EditProject 

OptionsStatistical Assumptions… and setting the Sample scaling constant to 

1.  This causes the sample size used in significance testing to be equivalent to the sum 

of the weights.  If the weights are set to have an average of 1.0 the statistical tests 

assume a sample size equal to the observed sample size (which has the effect of 

exaggerating the precision of most surveys).  If the weights are set so that the 

sample is grossed up to the population, it is advisable to use Q’s default approach 

(Compute from effective sample size) or to set a more appropriate sample scaling 

constant (e.g., the sum of the weights divided by the population size). 
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Smart tables 

Sometimes it is useful to compare the statistical significance between one key 

question and a variety of other questions.  For example, we might wish to understand 

the relationship between brand choice and an assortment of demographic questions.  

This process is automated using Smart Tables, as follows: 

 Create a table by selecting the question of interest (i.e., the dependent 

question) in the blue drop-down menu. 

 Select Create  Smart Tables….  The Smart Tables dialog box will appear – 

see Figure 29. 

 

 

Figure 29.  Smart Tables dialog box 

 Select the questions to compare against by clicking on them in the list of 

questions on the left and pressing the  button.   Some types of questions 

cannot be used in Smart Tables (text questions, two dimensional questions and 

Pick One – Multi questions).  This is because it does not make sense to use 

such questions; they can be converted into more appropriate types of 

questions and then used – see Online Training. 
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 If you are having difficulty identifying the questions you wish to compare 

against, you can type some characters into the Find box. Q will automatically 

identify questions with labels containing the characters you have typed.  To 

find the next question with a label containing the characters you have typed, 

press .  

The Smart Tables output is a set of tables, appended to the Report.  The tables form 

a part of a Group named after the dependent question (with Smart Tables affixed at 

the end; e.g., Q7. Company currently with: Smart Tables – see Figure 30).  Within this 

Group there are two sub-groups – one called Significant (p <= 0.025) which contains 

questions which were significantly related to the dependent question and another 

showing the insignificant questions.  The cut-off p-value is determined by the settings 

of the Significance level and  Multiple comparisons method – see the Q Reference 

Manual.  Within each group, the tables are ordered according to their p-values. 

 

Figure 30.  Smart Tables output 
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Maps 

Select Create and Map… to create a correspondence analysis map of a table.  An 

expert system selects the appropriate correspondence analysis algorithm and 

performs any required additional data manipulations. 

By default Q produces a moon plot in PowerPoint.  The moon plot is more easily 

interpreted than the traditional maps – see Figure 31.  Alternatively, traditional scatter 

plots can be exported into Excel, Word and PowerPoint. 

Maps can be created from crosstabs, from summaries of Pick One – Multi and grid 

questions. 

 

Figure 31.  Moon plot 
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Choice modeling and experiments 

Q can analyze all the standard choice modeling methods, including discrete choice 

experiments, ratings and rankings based-conjoint and best-worst (sometimes known 

as max-diff). 

Choice modeling data is setup with a Question Type of Experiment.  Detailed 

instructions for their setup are contained in the Q Reference Manual. 

Once an experiment has been setup, it is treated in the same way as any other 

question in Q.  When selected in the blue drop-down menu, the coefficients of the 

model are automatically estimated and displayed (e.g., using MNL if choice data).  

Experiments can be crosstabbed with other questions; the resulting significance tests 

then compare the coefficients of the different models (for example, Figure 32 shows 

differences between coefficients of a choice model and age).  Filters can be applied.  

Smart Tables can be used to find the other questions most strongly associated with 

the experiment.  Latent class analysis and trees can be created that identify segments 

with different coefficients. 

 

Figure 32.  Cross-tabbing an experiment 

There are some specific tools just for analyzing experiments.  If all the cells in a table 

are selected and  is pressed, various model diagnostics will be displayed.  If latent 

classes or a tree has been created (see page 60), right-click on the tree and select 

Save Individual-Level Parameter Means and Standard Deviations to produce 

estimates of the coefficients for each respondent. 
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Latent class analysis and trees  

Segments can be formed using latent class analysis with one or more questions by 

selecting Create  Segments… and selecting appropriate questions as Questions to 

analyze.  Figure 33 shows segments formed using numeric and categorical data. 

 

Figure 33.  Latent class analysis of brand and number of long-distance calls 

Trees can be created which predict the Questions to analyze using other questions.  

Figure 34 shows a tree which predicts brand choice and number of long-distance 

phone calls by income, age and education.  Worked Example 6 shows how this tree 

was created. 

 

Figure 34.  Tree predicting brand and number of long-distance calls 
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Worked Example 6: Trees 

1. From the File menu select Open Existing Project... and select Phone 

Records.Q, which will be in c:\Program Files\Q\Examples (unless Q has 

been installed in a different location on your computer). 

2. Click on the Create menu and select Segments…. 

3. Select Brand and press the  button so that Brand and Number monthly long-

distance calls are selected as Questions to analyze. 

4. Set Form segments by… to splitting by questions (tree). 

5. Select all the variables except for Brand and Number monthly long-distance 

calls and press the  button. 

6. Press Advanced…. 

7. Set Maximum number of tree levels to 10. 

8. Set Model selection criteria to AIC.  This creates a bigger tree than the default 

BIC. 

9. Press OK twice. 
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Dates and time series plots 

Dates can easily be converted to different time scales (e.g., months, weeks, quarters).  

Time series plots can be created which automatically update with new data, 

automatically smoothed and can be exported or cut-and-pasted into Word and 

PowerPoint.    

 Worked Example 7: Dates and time questions 

1. From the File menu select Open Existing Project... and select Time Series 

Tutorial.Q, which will be in c:\Program Files\Q\Examples (unless Q has 

been installed in a different location on your computer). 

2. Click on the Create menu and select Time Series Plot…. 

3. Select Satisfaction in the blue drop-down menu on the left. 

4. Right-click on the horizontal axis and select Format Axis…. 

5. Select the Date Question tab. 

6. Change the Aggregation from Week to Month.  This will make the categories 

show months rather than weeks. 

7. Change Period type to Duration. 

8. Set the Duration to 6 months.  The table will now only show the last 6 months of 

data.  (Do not close this dialog box at this stage.) 

9. Click on the pink line. 

10. Select the Time Series Analysis tab. 

11. Change the Density to Uniform and the Bandwidth to 3; this creates a 3 month 

rolling average. 

12. Press Close.   
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Coding 

Q’s coding facilities allow you to: 

 Code single response, multiple response and looped questions. 

 Back-code “other specify” questions.   

 Automatically recode near-identical responses.  For example, once you have 

coded a specific text response, such as Coce as Coke, Q will automatically 

recode any other responses using the same spelling into Coke, even if they use 

different punctuation, capitalization or spaces. 

 Import and export code frames.  This imports both the names of the codes and 

the rules about which text responses go in which code names.   

The worked example below introduces the basics of coding.  More detail is in the Q 

Reference Manual. 

Worked Example 8: Coding 

1. From the File menu select Import New Data File (New Project)... and select 

Discount.csv, which will be in c:\Program Files\Q\Examples (unless Q 

has been installed in a different location on your computer). 

2. Press Yes and Yes. 

3. In the blue drop-down menu type qd6 and press Enter on your keyboard.  You 

are now looking at the raw text responses. 

4. Press  (to the right of the blue drop-down).  This selects the question in the 

Variables and Questions tab. 

5. Right-click on the selected question and select Insert Variable(s)  Code Text  

New Code Frame…. 

6. Select Pick One and press OK.  (We would select Pick Any if coding multiple 

response data.) 

7. Right-click on New Code and select Rename…. 

8. Type White Collar and press OK. 

9. Right-click on White Collar, select Add Code, type Blue Collar and press OK. 
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10. Note that the text we are about to code is Public Servant and five 

respondents have given this answer (differences in punctuation and spacing are 

ignored). 

11. Click on White Collar. 

12. The next response is REP/CAR PARTS.  Click on Blue Collar. 

13. Keep going until all responses are coded.  Answers that suggest the respondent 

does not have a job should be coded as Missing Data.   

14. When you have finished, press OK.  A new question, named Qd6 - Coded, will 

now appear in row 32.   

15. Double-click on .  The question will now be displayed in the Tables tab.  It 

works just like any other question (i.e., it can be filtered, cross-tabbed, etc.).   
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Traditional multivariate analysis 

Additional advanced analyses are available by selected Create and Traditional 

Multivariate Analysis. 

Cluster Analysis forms clusters of similar observations.  Q uses k-

means cluster analysis.  Q uses a state-of-the-art expert system to determine the 

number of clusters; this is useful if you need to prove that the clusters that have been 

identified are, in some sense, the real and true clusters.  In most instances, latent 

class analysis (see page 60) should be used instead of cluster analysis, as it takes into 

account missing data and can appropriately address rankings, categorical and 

experimental data. 

Principal Components Analysis identifies interrelationships 

between variables.  It is useful for identifying underlying 

dimensions of consumer behavior, summarizing data and 

identifying redundant questions in questionnaires. 

Regression quantifies relationships between a dependent variable 

(e.g., overall satisfaction) and various drivers (e.g., satisfaction with different aspects 

of a firm’s performance).  Q examines the data to determine the appropriate method, 

choosing between binary logit, ordered logit, linear regression and multinomial logistic 

discriminant analysis. 

Cluster Analysis 

Principal 

Components 

Analysis  

Regression 
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